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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 2540p Notebook PC

Processors Intel® Dual Core™ processors (support Intel Turbo Boost Technology):

● Intel Dual Core i7-640LM 2.13-GHz processor, (turbo up to 2.93-GHz), 4-MB L3 cache, 4
threads, low-voltage (25-W)

● Intel Dual Core i7-620M 2.66-GHz processor, (turbo up to 3.33-GHz), 4-MB L3 cache, 4
threads, standard-voltage (35-W)

● Intel Dual Core i5-540M 2.53-GHz processor, (turbo up to 3.06-GHz), 3-MB L3 cache, 4
threads, standard-voltage (35-W)

● Intel Dual Core i5-520M 2.40-GHz processor, (turbo up to 2.93-GHz), 3-MB L3 cache, 4
threads, standard-voltage (35-W)

Chipset Mobile Intel QM57 Express chipset (non-HDI)

Graphics Intel HD Graphics with up to 512-MB unified memory architecture (UMA) graphics subsystem
memory

Panel All display assemblies include 2 wireless local area network (WLAN) antenna cables and 2 wireless
wide area network (WWAN) antenna cables:

● 12.1-in WXGA light-emitting diode (LED), AntiGlare (AG) with webcam

● 12.1-in WXGA LED, AG without webcam

Supports privacy filter

Supports 16:10 resolution

Supports 1280 ×800 resolution

Memory 2 customer-accessible/upgradable memory module slots

 Supports up to 8192 GB of system RAM

 DDR3 1333-MHz, PC3-10600
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Category Description

 Supports the following configurations:

● 8192-MB total system memory (4096 × 2)

● 6144-MB total system memory (4096 + 2048)

● 4096-MB total system memory (4096 × 1, 2048 × 2)

● 3072-MB total system memory (2048 + 1024)

● 2048-MB total system memory (2048 × 1, 1024 × 2)

● 1024-MB total system memory (1024 × 1)

Internal storage Computer models equipped with a standard-voltage (35-W) processor support the following 2.5-in
storage devices:

● 500-GB hard drive (7200-rpm, SMART SATA II)

● 320-GB hard drive (7200-rpm, SMART SATA II)

● 320 self-encrypting drive (SED) GB hard drive (7200-rpm, SMART SATA II)

● 250-GB hard drive (7200-rpm, SMART SATA II)

–or–

● 160-GB solid-state drive

● 80-GB solid-state drive

NOTE: The 1.8-in hard drive bay is not supported on computer models equipped with a standard-
voltage (35-W) processor.

 Computer models equipped with a low-voltage (25-W) processor support the following storage
devices:

● In the 1.8–in hard drive bay:

◦ 320-GB hard drive (5400-rpm, SMART SATA II)

◦ 250-GB hard drive (5400-rpm, SMART SATA II)

◦ 160-GB hard drive (5400-rpm, SMART SATA II)

–or–

◦ 160-GB solid-state drive

◦ 80-GB solid-state drive

● In the 2.5-in hard drive carrier (for RAID support): 2.5-in, 250-GB, 7200-rpm SMART SATA II
hard drive (requires the installation of a 1.8-in, 250-GB, 5400-rpm hard drive in the 1.8-in hard
drive bay)

NOTE: Internal storage devices are customer-removable and will withstand multiple insertion and
removal cycles. Up to 15 GB is reserved for the system recovery software.

Optical drives NOTE: The optical drive is an optional feature and is available only on computer models equipped
with a low voltage (25-W) processor.

 Fixed (removal of 1 screw required)

 Customer-accessible

 Serial ATA
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Category Description

 9.5-mm tray load

 Supports the following drives:

● DVD±RW and CD-RW SuperMulti Double-Layer Drive

● DVD-ROM Drive

Audio and video Integrated dual-array microphones

 IDT 92HD75B high-definition (HD) audio

 Supports 2 stereo speakers

 Integrated 2.0-megapixel webcam with macro focus for business card reader

Modem 56K V.92 1.5-in data/fax modem

 Supports “no modem” option

 Modem cable not included

Ethernet Intel 82577-LM 10/100/1000 GB network interface card (NIC) with iAMT 4.0 support

 S3/S4/S5 wake on LAN: DC - no

 S3/S4/S5 wake on LAN: AC - yes

 NIC power-down technology

 Ethernet cable not included

Wireless Integrated wireless local area network (WLAN) options by way of wireless module:

 Two WLAN antennas built into display assembly

 Support for no WLAN option

 Support for the following WLAN formats:

● Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter

● Broadcom 4312G 802.11b/g WiFi Adapter

● Intel Centrino Advanced-N 6200 WLAN module

 Integrated wireless wide area network (WWAN) options by way of wireless module:

 Two WWAN antennas built into display assembly (world-wide, 5-band)

 Support for no WWAN option

 Supports WWAN after-market option (product number WD301AA)

 Security provided by Subscriber Identify Module (SIM) located inside battery bay

 Support for the following WWAN formats:

● High-Speed Packet Access (HSPA) WWAN module

● HSPA Evolution-Data Optimized (EV-DO) WWAN module

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Broadcom Bluetooth specification v2.1 compliant

 Support for no-WPAN option
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Category Description

External media card One ExpressCard34 slot, supporting USB and PCIe ExpressCard modules

 One Digital Media Reader slot, supporting MultiMediaCard (MMC) and Secure Digital (SD) Memory
Card optional digital card formats.

Ports ● 1394a

● 3-pin AC power

● Headphone/microphone combo audio

● DisplayPort

● Docking

● RJ-11 (modem)

● RJ-45 (Ethernet, includes link and activity lights)

● USB 2.0 (4 on computer models equipped with standard voltage processors, 3 on computer
models equipped with low voltage processors; 1 powered)

● VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz (hot plug/unplug with
auto-detect)

Docking HP 2540 Docking Station

Keyboard/pointing
devices

Full-size keyboard

Dual point (pointing stick and TouchPad with scroll zone)

 Spill-resistant keyboard with HP drainage system

Power requirements 65-W HP Smart AC adapter with localized cable plug support (3-wire plug with ground pin, supports
3-pin DC connector)

 Supports HP Fast-Charge technology

Supports the following primary batteries:

● 9-cell, 2.80-Ah (93-WHr) Li-ion battery

● 6-cell, 2.80-Ah (62-WHr) Li-ion battery

● 6-cell, 2.80-Ah (55-WHr) Li-ion long life battery

● 3-cell, 2.80-Ah (31-WHr) Li-ion battery

● 3-cell, 2.80-Ah (28-WHr) Li-ion long life battery

Security Integrated fingerprint reader (select models only)

Integrated smart card reader (active)

Full-volume encryption

Security cable slot

Trusted platform module (TPM) v.1.2
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Category Description

Operating system Preinstalled:

● Windows® 7 Home Premium 32/64

● Windows 7 Professional 32/64

● Windows Vista® Home Basic

● Windows Vista Business 32 with Windows 7 license

● Windows XP Professional 32 with Windows 7 license

● FreeDOS

 Preinstalled with Microsoft® Office:

● Windows 7 Home Basic 32

● Windows 7 Home Premium 32/64

● Windows 7 Professional 32/64

● Windows Vista Home Basic

● Windows Vista Business 32 with Windows 7 license

● Windows Vista Business 32 with Windows 7 license with Personal without PowerPoint

● Windows Vista Business 32 with Windows 7 license with Personal with PowerPoint

● Windows Vista Business 32 with Windows 7 license with Professional

● Windows XP Professional 32 with Windows 7 Professional license

 Restore media (OSDVD):

● Windows 7 Home Basic 32

● Windows 7 Home Premium 32/64

● Windows 7 Professional 32/64

● Windows Vista Business 32

● Windows Vista Home Basic

● Windows XP Professional 32

 Certified: SUSE Linux Enterprise Desktop

 Office restore media: Office Ready restore DVD

 DRDVD (Device driver and Application DVD):

● Windows 7 with WINDVD

● Windows 7 without WINDVD

● Windows Vista

● Windows XP Professional
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Category Description

 Supported:

● Microsoft WHQL

● Novell

 Web-only support:

● Windows 7 Enterprise 32/64

● Windows 7 Ultimate 32/64

● Windows Vista Business 64

● Windows Vista Enterprise 32/64

Serviceability End-user replaceable parts:

● AC adapter

● Bluetooth module

● Battery

● Expansion memory module

● Hard drive

● Optical drive

● Power cord

● Primary memory module

● RTC battery

● SIM

● Solid-state drive

● WLAN module

● WWAN module
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2 External component identification

Components included with the computer may vary by region and model. The illustrations in this
chapter identify the standard features on most computer models.

To see a list of hardware installed in the computer, follow these steps:

In Windows 7:

▲ Select Start > Control Panel > System and Security > Device Manager.

In Windows Vista:

1. Select Start > Computer > System Properties.

2. In the left pane, click Device Manager.

NOTE: Windows 7 and Windows Vista use the User Account Control feature to improve the security
of your computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

In Windows XP:

1. Select Start > My Computer.

2. In the left pane of the System Tasks window, select View system information.

3. Select Hardware tab > Device Manager.

You can also add hardware or modify device configurations using Device Manager.
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Display components

Item Component Description

1 WWAN antennas (2)* Send and receive wireless signals to communicate
with WWANs (select models only).

2 WLAN antennas (2)* Send and receive wireless signals to communicate
with WLANs (select models only).

3 Webcam light On: The webcam is in use.

4 Webcam Records audio and video and captures still
photographs.

5 Keyboard light and button Opens and turns on the keyboard light, which
illuminates the keyboard in low-light conditions.

6 Internal microphones (2) Record sound.
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Item Component Description

7 Ambient light sensor Automatically adjusts the display brightness based on
the lighting conditions in your environment.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to
your country or region. These notices are located in Help and Support.
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Buttons and fingerprint reader
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Item Component Description

(1) Power button ● When the computer is off, press the button to
turn on the computer.

● When the computer is on, press the button to
shut down the computer.

NOTE: Although you can shut down the
computer with the power button, the
recommended procedure is to use the Windows
Shut down command (in Windows 7) or
Windows Shut Down command (in Windows
Vista and Windows XP).

● When the computer is in the Sleep state (in
Windows 7 and Windows Vista) or in Standby (in
Windows XP), press the button briefly to exit
Sleep (in Windows 7 and Windows Vista) or
Standby (in Windows XP).

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold
the power button for at least 5 seconds to turn off the
computer.

To learn more about your power settings, select:

● In Windows 7, select Start > Control Panel >
System and Security > Power Options

● In Windows Vista, select Start > Control Panel
> System and Maintenance > Power Options

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power
Options.

(2) QuickLook button ● When the computer is off, press the button to
open HP QuickLook.

● When the computer is on, press the button to
open HP Software Setup.

NOTE: If HP Software Setup is not available,
the default Web browser opens.

(3) QuickWeb button ● When the computer is off, press the button to
open HP QuickWeb.

● When the computer is on, press the button to
open the default Web browser.

(4) Wireless button Turns the installed wireless devices on or off but does
not establish a wireless connection.

NOTE: A wireless network must be set up in order
to establish a wireless connection.

(5) TouchPad on/off button Turns the TouchPad on or off.

(6) Volume mute button Mutes and restores speaker sound.

(7) Volume down button Decreases speaker volume.
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Item Component Description

(8) Volume up button Increases speaker volume.

(9) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a
password logon.
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Keys

Item Component Description

(1) esc key Displays system information when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when
pressed in combination with a function key or the esc
key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the
pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric
keypad.

(6) Function keys Execute frequently used system functions when
pressed in combination with the fn key.
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Pointing device components

Item Component Description

(1) Left TouchPad button* Functions like the left button on an external mouse.

(2) TouchPad* Moves the pointer and selects or activates items on
the screen.

(3) Left pointing stick button* Functions like the left button on an external mouse.

(4) Pointing stick* Moves the pointer and selects or activates items on
the screen.

(5) TouchPad on/off button Turns the TouchPad on and off.

(6) Right pointing stick button* Functions like the right button on an external mouse.

(7) TouchPad scroll zone Scrolls up or down.

(8) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

● In Windows 7, select Start > Devices and Printers. Then, right-click the device representing your computer, and select
Mouse settings.

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Front components

Item Component Description

(1) Business card slot Holds a business card in position so that the webcam
can capture the information on the card.

(2) Wireless light ● Blue: An integrated wireless device, such as a
WLAN device, the HP Mobile Broadband Module
(select models only), and/or a Bluetooth device,
is on.

● Amber: All wireless devices are off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state
(Windows 7 and Windows Vista) or Standby
(Windows XP).

● Off: The computer is off or in Hibernation.

(4) Battery light ● Amber: A battery is charging.

● White: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only
available power source has reached a low
battery level. When the battery reaches a critical
battery level, the battery light begins blinking
rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all
batteries in the computer are fully charged. If the
computer is not plugged into an external power
source, the light stays off until the battery
reaches a low battery level.

(5) Drive light ● White: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily
parked the hard drive.

(6) Speakers (2) Produce sound.

(7) Display release button Opens the computer.
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Left-side components
NOTE: Refer to the illustration that most closely matches your computer.

Computer model equipped with a low-voltage processor

Item Component Description

(1) Power connector Connects an AC adapter.

(2) RJ-11 (modem) jack Connects a modem cable (select models only).

(3) Powered USB port Provides power to a USB device, such as an optional
external MultiBay or an optional external optical drive,
if used with a powered USB cable.

(4) Optical drive Reads and writes to (select models only) an optical
disc.

(5) Smart card reader Supports optional smart cards and Java™ Cards.

Computer model equipped with a standard-voltage processor

Item Component Description

(1) Power connector Connects an AC adapter.

(2) RJ-11 (modem) jack Connects a modem cable (select models only).

(3) Powered USB port Provides power to a USB device, such as an optional
external MultiBay or an optional external optical drive,
if used with a powered USB cable.

(4) USB port Connects an optional USB device.

(5) Hard drive bay Holds a 2.5-in hard drive.

(6) Smart card reader Supports optional smart cards and Java Cards.
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Rear components

Item Component Description

(1) RJ-45 network) jack Connects a network cable.

(2) USB ports (2) Connect optional USB devices.
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Right-side components

Item Component Description

(1) ExpressCard34 slot Supports optional ExpressCards.

(2) Docking connector Connects an optional docking device.

(3) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from
being mishandled or stolen.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off during
routine operation.

(5) DisplayPort Connects a digital display device, such as a high-
performance monitor or projector.

(6) External monitor port Connects an external VGA monitor or projector.

(7) Audio-out (headphone) jack/Audio-in (microphone)
jack

Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset,
or television audio. Also connects an optional headset
microphone.

NOTE: When a device is connected to the
headphone jack, the computer speakers are disabled.

(8) 1394 port Connects an optional IEEE 1394 or 1394a device,
such as a camcorder.

(9) SD Card Reader Supports the MultiMediaCard (MMC) and Secure
Digital (SD) Memory Card optional digital card
formats.
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Bottom components

Item Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.

(3) Vents (7) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off during
routine operation.

(4) SIM slot (select models only) Contains a wireless SIM. The SIM slot is located
inside the battery bay.

(5) Hard drive bay and memory module compartment Holds a 1.8-in hard drive and contains an expansion
memory module slot.

NOTE: If the computer is equipped with a 1.8-in
hard drive or solid-state drive, it is installed in this
location. If the computer is equipped with a 2.5-in
hard drive or solid-state drive, it is installed in the
optical drive bay (see item 8).

(6) Speakers (2) Produce sound.
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Item Component Description

(7) Wireless module compartment Contains an HP Mobile Broadband Module (select
models only) and a WLAN module (select models
only).

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless
module authorized for use in the computer by the
governmental agency that regulates wireless devices
in your country or region. If you replace the module
and then receive a warning message, remove the
module to restore computer functionality, and then
contact technical support through Help and Support.

(8) Optical drive bay or hard drive bay Holds an optical drive or a 2.5-in hard drive.

NOTE: If the computer is equipped with a low-
voltage (25-W) processor, an optical drive will be
installed in this location. If the computer is equipped
with a standard-voltage (35-W) processor, a hard
drive will be installed in this location.
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3 Illustrated parts catalog

Serial number location
The service tag, affixed to the bottom of the computer, provides information that may be needed
when troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components
and parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: This number describes the duration of the warranty period for the computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer major components
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Item Description Spare part number

(1) 12.1-in, WXGA AntiGlare LED display assembly (includes display panel cable, WLAN antenna transceivers
and cables, and WWAN antenna transceivers and cables. See Display components on page 30 for display
assembly component spare part number information.):

 For use only with computer models equipped with a webcam 598794-001

 For use only with computer models not equipped with a webcam 598795-001

(2) Switch cover (includes display lid switch board and cable and capacitive board and
cable)

598800-001

(3) Keyboard with pointing stick (includes keyboard cable and pointing stick cable):

 ● For use in Belgium 598790-A41

 ● For use in Brazil 598790-201

 ● For use in Bulgaria 598790-261

 ● For use in the Czech Republic 598790-221

 ● For use in Denmark 598790-081

 ● For use in Finland and Sweden 598790-B71

 ● For use in France 598790-051

 ● For use in French Canada 598790-121

 ● For use in Germany 598790-041

 ● For use in Greece 598790-DJ1

 ● For use in Hungary 598790-211

 ● For use in Iceland 598790-DD1

 ● For use in Israel 598790-BB1

 ● For use in Italy 598790-061

 ● For use in Japan 598790-291

 ● For use in Latin America 598790-161

 ● For use in the Netherlands 598790-B31

 ● For use in Norway 598790-091

 ● For use in Portugal 598790-131

 ● For use in Russia 598790-251

 ● For use in Saudi Arabia 598790-171

 ● For use in Slovakia 598790-231

 ● For use in Slovenia 598790-BA1

 ● For use in South Korea 598790-AD1

 ● For use in Spain 598790-071

 ● For use in Switzerland 598790-BG1

 ● For use in Taiwan 598790-AB1

24 Chapter 3   Illustrated parts catalog ENWW



Item Description Spare part number

 ● For use in Thailand 598790-281

 ● For use in Turkey 598790-141

 ● For use in the United Kingdom 598790-031

 ● For use in the United States 598790-001

(4) RTC battery 481089-001

(5) Memory shield 598793-001

(6) Memory modules (2, 1333-MHz, DDR3):

 4 GB 599092-002

 2GB 598856-002

 1GB 598859-002

(7) Top cover (includes TouchPad board and cable, TouchPad button board and cable, and TouchPad bracket):

 For use only with computer models equipped with a fingerprint reader 598801-001

 For use only with computer models not equipped with a fingerprint reader 598802-001

 Plastics Kit, includes: 598796-001

(8a) ExpressCard slot bezel

(8b) Wireless module compartment cover

(8c) Bluetooth module compartment cover

(8d) Memory module compartment cover

 NOTE: The Plastics Kit also includes the display hinge covers and the optical drive bezel, which are not
illustrated. See Plastics Kit on page 33 for more Plastics Kit spare part information.

(9) Card reader board and cable 598768-001

(10) Card reader board bracket 598767-001

(11) Speaker 598799-001

(12) Bluetooth module cable (included in the Cable Kit, spare part number 598766-001)

(13) System board (includes processor, replacement thermal material, and replacement thermal material cleaning
kit):

 System boards for use on computer models equipped with a standard-voltage (35-W) processor:

 Equipped with an Intel Core i7-620M 2.66-GHz processor for use in all countries and
regions except the People's Republic of China and Russia

598765-001

 Equipped with an Intel Core i7-620M 2.66-GHz processor for use only in the People's
Republic of China and Russia

614968-001

 Equipped with an Intel Core i5-540M 2.53-GHz processor for use in all countries and
regions except the People's Republic of China and Russia

598764-001

 Equipped with an Intel Core i5-540M 2.53-GHz processor for use only in the People's
Republic of China and Russia

614967-001

 Equipped with an Intel Core i5-520M 2.40-GHz processor for use in all countries and
regions except the People's Republic of China and Russia

598763-001
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 Equipped with an Intel Core i5-520M 2.40-GHz processor for use only in the People's
Republic of China and Russia

614966-001

 System boards for use on computer models equipped with low-voltage (25-W) processors:

 Equipped with an Intel Core i7-640M 2.13-GHz processor for use in all countries and
regions except the People's Republic of China and Russia

598762-001

 Equipped with an Intel Core i7-640M 2.13-GHz processor for use only in the People's
Republic of China and Russia

614965-001

(14) Modem module:

NOTE: The modem module spare part kit does not include a modem module cable. The modem module cable
is included in the Cable Kit, spare part number 598766-001.

 For use in all countries and regions except Australia and New Zealand 510099-001

 For use only in Australia and New Zealand 510099-011

(15) Modem module cable (includes RJ-11 connector, included in the Cable Kit, spare part number 598766-001)

(16) Fan/heat sink assembly (includes replacement thermal material and replacement thermal material cleaning kit):

 For use only with a standard-voltage (35-W) processor 598789-001

 For use only with a low-voltage (25-W) processor 598788-001

(17) Optical drive (includes bezel and bracket):

 DVD±RW and CD-RW SuperMulti Double-Layer Drive 598776-001

 DVD-ROM Drive 598775-001

 NOTE: The optical drive is an optional feature and is available only on computer models equipped with a low
voltage (25-W) processor.

(18) Hard drive carrier 598786-001

(19) Base enclosure (includes display release latch, battery release latch, LED board and
cable, and rubber feet)

598759-001

 Rubber Kit (includes display bezel rubber bumbers, display bezel screw covers, RJ-11
jack cover, rubber feet, and Mylar used in the WLAN module compartment)

598797-001

(20) Battery  

 9-cell, 93-WH, 2.8-AH, Li-ion battery 593587-001

 6-cell, 62-WH, 2.8-AH, Li-ion battery 593586-001

 6-cell, 55-WH, 2.8-AH, Li-ion long life battery 593585-001

 3-cell, 31-WH, 2.8-AH, Li-ion battery 492548-001

 3-cell, 28-WH, 2.8-AH, Li-ion long life battery 593584-001

(21) HP Integrated Module with Bluetooth 2.1 Wireless Technology

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module
cable. The Bluetooth module cable is included in the Cable Kit, spare part number
598766-001.

537921-001

(22) WLAN module
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 Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Antigua and Barbuda,
Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada,
the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia,
Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

582564-001

 Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Afghanistan, Albania,
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia,
Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay,
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

582564-002

 Broadcom 4312G 802.11b/g WiFi Adapter for use in Antigua and Barbuda, Argentina,
Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile,
Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam,
Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela,
and Vietnam

582562-001
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 Broadcom 4312G 802.11b/g WiFi Adapter for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay,
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

582564-002

 Intel Centrino Advanced-N 6200 WLAN module for use in the United States
and Canada

572509-001

(23) WWAN module

 HP un2420 Broadband Module for use in all countries and regions 531993-001

 HP hs2330 HSPA Mobile Broadband Module for use in all countries and regions 574249-001

 HP hs2320 HSPA Mobile Broadband Module for use only in Europe, the Middle East,
and Africa

NOTE: For use only on selected computer models.

574248-001

(24) Hard drive and solid-state drive

 4.57-cm (1.80-in) hard drive:

NOTE: The 4.57-cm (1.80-in) hard drive must be installed in the hard drive bay. Installation of this drive in the
optical drive bay is not supported.

 ● 320-GB, 5400-rpm hard drive 614537-001

 ● 250-GB, 5400-rpm hard drive 598778-001

 ● 160-GB, 5400-rpm hard drive 598777-001

 4.57-cm (1.80-in) solid-state drive:

NOTE: The 4.57-cm (1.80-in) solid-state drive must be installed in the hard drive bay. Installation of this drive in
the optical drive bay is not supported.

 ● 160-GB solid-state drive 598782-001

 ● 80-GB solid-state drive 602675-001
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 6.35-cm (2.50-in) hard drive:

NOTE: The 6.35-cm (2.50-in) hard drive must be installed in the optical drive bay, using a hard drive carrier.
Installation of these devices in the hard drive bay is not supported. (This option is not available when the optical
drive is installed.)

 ● 500-GB, 7200-rpm hard drive 598781-001

 ● 320-GB, 7200-rpm hard drive 598780-001

 ● 320-GB, 7200-rpm SED hard drive 618243-001

 ● 250-GB, 7200-rpm hard drive 598779-001

 6.35-cm (2.50-in) solid-state drive:

NOTE: The 6.35-cm (2.50-in) solid-state drive must be installed in the optical drive bay, using a hard drive
carrier. Installation of these devices in the hard drive bay is not supported. (This option is not available when the
optical drive is installed.)

 ● 160-GB, solid-state drive 598783-001

 ● 80-GB, solid-state drive 602676-001

(25) Hard drive shield (includes two captive screws, included with the hard drive spare part kit)
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Item Description Spare part number

(1) Display bezel

 For use only with computer models equipped with a webcam 598770-001

 For use only with computer models not equipped with a webcam 598771-001

(2) Webcam module 598803-001

(3) Ambient light sensor board 598761-001

(4) Display Hinge Kit, includes: 598773-001

(5) Display panel cable (includes webcam module cable and ambient light sensor board
cable)

598772-001

(6) Display enclosure (includes microphone receivers and cables, WLAN antenna cables
and transceivers, and WWAN antenna cables and transceivers)

598769-001
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Item Description Spare part number

(1) 6.35-cm (2.50-in) mass storage device

NOTE: 6.35-cm (2.50-in) devices must be installed in the optical drive bay, using a hard drive carrier.
Installation of 6.35-cm (2.50-in) devices in the hard drive bay is not supported.

 6.35-cm (2.50-in) mass storage devices available for use on computer models equipped with a standard-voltage
(35-W) processor:

 ● 500-GB, 7200-rpm hard drive 598781-001

 ● 320-GB, 7200-rpm hard drive 598780-001

 ● 320-GB, 7200-rpm SED hard drive 618243-001

 ● 250-GB, 7200-rpm hard drive 598779-001

 ● 160-GB solid-state drive 598783-001

 ● 80-GB solid-state drive 602676-001

 A 6.35-in (2.50-in), 250-GB. 7200-rpm, hard drive, spare part number 598779-001, can be used on computer
models equipped with a low-voltage (25-W) processor. Use of this hard drive requires the use of a 1.8-in, 250-
GB, 5400-rpm hard drive in the 1.8-in hard drive bay for RAID support.
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(2) 4.57-cm (1.80-in) mass storage device

NOTE: 4.57-cm (1.80-in) devices must be installed in the hard drive bay. Installation of these devices in the
optical drive bay is not supported.

 4.57-cm (1.80-in) mass storage devices available for use on computer models equipped with a low-voltage (25-
W) processor:

 ● 320-GB, 5400-rpm hard drive 614537-001

 ● 250-GB, 5400-rpm hard drive 598778-001

 ● 160-GB, 5400-rpm hard drive 598777-001

 ● 160-GB solid-state drive 598782-001

 ● 80-GB solid-state drive 602675-001

(3) Hard drive carrier 598786-001

(4) Optical drive (includes bezel and bracket):

 DVD±RW and CD-RW SuperMulti Double-Layer Drive 598776-001

 DVD-ROM Drive 598775-001
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Item Description Spare part number

 Plastics Kit: 598796-001

(1) Optical drive bezel

(2) Wireless module compartment cover (includes one captive screw, secured by a C-clip)

(3) ExpressCard slot bezel

(4) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(5) Display hinge covers

(6) Bluetooth module compartment cover (includes one captive screw, secured by a C-clip)
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Miscellaneous parts
Description Spare part number

AC adapter

65-W non-PFC AC adapter 613152-001

65-W PFC AC adapter 613161-001

Cable Kit (includes Bluetooth module cable and modem module cable) 598766-001

HP 2540 Series Docking Station 598774-001

Power cord

For use in Argentina 490371-D01

For use in Australia and New Zealand 490371-011

For use in Brazil 490371-202

For use in Canada and the United States 490371-001

For use in Denmark 490371-081

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

Power cord for use in Singapore and the United Kingdom 490371-031

Screw Kit 598798-001

34 Chapter 3   Illustrated parts catalog ENWW



Sequential part number listing
Spare part
number
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481089-001 RTC battery

490371-001 Power cord for use in Canada and the United States

490371-011 Power cord for use in Australia and New Zealand

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in Singapore and the United Kingdom

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-202 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

492548-001 3-cell, 31-WH, 2.8-AH, Li-ion battery

510099-001 Modem module for use in all countries and regions except Australia and New Zealand

NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 598766-001.

510099-011 Modem module for use only in Australia and New Zealand

NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 598766-001.

531993-001 HP un2420 Broadband Module for use in all countries and regions

537921-001 HP Integrated Module with Bluetooth 2.1 Wireless Technology

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 598766-001.

572509-001 Intel Centrino Advanced-N 6200 WLAN module for use in Canada and the United States

574248-001 HP hs2320 HSPA Mobile Broadband Module for use only in Europe, the Middle East, and Africa

NOTE: For use only on selected computer models.

574249-001 HP hs2330 HSPA Mobile Broadband Module for use in all countries and regions
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582562-001 Broadcom 4312G 802.11b/g WiFi Adapter for use in Antigua and Barbuda, Argentina, Aruba, the Bahamas,
Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica,
the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

582562-002 Broadcom 4312G 802.11b/g WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

582564-001 Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Antigua and Barbuda, Argentina, Aruba,
the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica,
the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

582564-002 Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

593584-001 3-cell, 28-WH, 2.8-AH, Li-ion long life battery

593585-001 6-cell, 55-WH, 2.8-AH, Li-ion long life battery
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593586-001 6-cell, 62-WH, 2.8-AH, Li-ion battery

593587-001 9-cell, 93-WH, 2.8-AH, Li-ion battery

598759-001 Base enclosure (includes display release latch, battery release latch, LED board and cable, and rubber feet)

598761-001 Ambient light sensor board

598762-001 System board equipped with an Intel Core i7-640LM 2.13-GHz, low-voltage (25-W) processor for use in all
countries and regions except the People's Republic of China and Russia (includes replacement thermal
material and replacement thermal material cleaning kit)

598763-001 System board equipped with an Intel Core i5-520M 2.40-GHz, standard-voltage (35-W) processor for use in
all countries and regions except the People's Republic of China and Russia (includes replacement thermal
material and replacement thermal material cleaning kit)

598764-001 System board equipped with an Intel Core i5-540M 2.53-GHz, standard-voltage (35-W) processor for use in
all countries and regions except the People's Republic of China and Russia (includes replacement thermal
material and replacement thermal material cleaning kit)

598765-001 System board equipped with an Intel Core i7-620M 2.66-GHz, standard-voltage (35-W) processor for use in
all countries and regions except the People's Republic of China and Russia (includes replacement thermal
material and replacement thermal material cleaning kit)

598766-001 Cable Kit (includes Bluetooth module cable and modem module cable)

598767-001 Card reader board bracket

598768-001 Card reader board and cable

598769-001 Display enclosure (includes WLAN antenna cables and transceivers and WWAN antenna cables and
transceivers)

598770-001 Display bezel for use only with computer models equipped with a webcam

598771-001 Display bezel for use only with computer models not equipped with a webcam

598772-001 Display panel cable (includes webcam module cable and ambient light sensor board cable)

598773-001 Display Hinge Kit (includes left and right display hinges and left and right hinge covers)

598774-001 HP 2540 Series Docking Station

598775-001 DVD-ROM Drive

598776-001 DVD±RW and CD-RW Super Multi Double-Layer Drive

598777-001 4.57-cm (1.80-in), 160-GB, 5400-rpm hard drive

598778-001 4.57-cm (1.80-in), 250-GB, 5400-rpm hard drive

598779-001 6.35-cm (2.50-in), 250-GB, 7200-rpm hard drive

598780-001 6.35-cm (2.50-in), 320-GB, 7200-rpm hard drive

598781-001 6.35-cm (2.50-in), 500-GB, 7200-rpm hard drive

598782-001 4.57-cm (1.80-in), 160-GB solid-state drive

598783-001 6.35-cm (2.50-in), 160-GB solid-state drive

598786-001 Hard drive carrier

598788-001 Fan/heat sink assembly for use only with 25-W processors (includes replacement thermal material and
replacement thermal material cleaning kit)
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Spare part
number

Description

598789-001 Fan/heat sink assembly for use only with 35-W processors (includes replacement thermal material and
replacement thermal material cleaning kit)

598790-001 Keyboard for use in the United States (includes cable)

598790-031 Keyboard for use in the United Kingdom (includes cable)

598790-041 Keyboard for use in Germany (includes cable)

598790-051 Keyboard for use in France (includes cable)

598790-061 Keyboard for use in Italy (includes cable)

598790-071 Keyboard for use in Spain (includes cable)

598790-081 Keyboard for use in Denmark (includes cable)

598790-091 Keyboard for use in Norway (includes cable)

598790-121 Keyboard for use in French Canada (includes cable)

598790-131 Keyboard for use in Portugal (includes cable)

598790-141 Keyboard for use in Turkey (includes cable)

598790-161 Keyboard for use in Latin America (includes cable)

598790-171 Keyboard for use in Saudi Arabia (includes cable)

598790-201 Keyboard for use in Brazil (includes cable)

598790-211 Keyboard for use in Hungary (includes cable)

598790-221 Keyboard for use in the Czech Republic (includes cable)

598790-231 Keyboard for use in Slovakia (includes cable)

598790-251 Keyboard for use in Russia (includes cable)

598790-261 Keyboard for use in Bulgaria (includes cable)

598790-281 Keyboard for use in Thailand (includes cable)

598790-291 Keyboard for use in Japan (includes cable)

598790-A41 Keyboard for use in Belgium (includes cable)

598790-AB1 Keyboard for use in Taiwan (includes cable)

598790-AD1 Keyboard for use in South Korea (includes cable)

598790-B31 Keyboard for use in the Netherlands (includes cable)

598790-B71 Keyboard for use in Finland and Sweden (includes cable)

598790-BA1 Keyboard for use in Slovenia (includes cable)

598790-BB1 Keyboard for use in Israel (includes cable)

598790-BG1 Keyboard for use in Switzerland (includes cable)

598790-DD1 Keyboard for use in India (includes cable)

598790-DJ1 Keyboard for use in Greece (includes cable)

598793-001 Memory shield
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Spare part
number

Description

598794-001 12.1-in, WXGA AntiGlare LED display assembly for use only with computer models equipped with a
webcam (includes display panel cable, WLAN antenna transceivers and cables, and WWAN antenna
transceivers and cables.

598795-001 12.1-in, WXGA AntiGlare LED display assembly for use only with computer models not equipped with a
webcam (includes display panel cable, WLAN antenna transceivers and cables, and WWAN antenna
transceivers and cables.

598796-001 Plastics Kit

NOTE: See Plastics Kit on page 33 for more Plastics Kit spare part information.

598797-001 Rubber Kit (includes display bezel rubber bumbers, display bezel screw covers, RJ-11 jack cover, rubber
feet, and Mylar used in the WLAN module compartment)

598798-001 Screw Kit

598799-001 Speaker

598800-001 Switch cover (includes display lid switch board and cable and capacitive board and cable)

598801-001 Top cover for use only with computer models equipped with a fingerprint reader (includes fingerprint reader
board and cable, TouchPad board and cable, TouchPad button board and cable, and TouchPad bracket)

598802-001 Top cover for use only with computer models not equipped with a fingerprint reader (includes TouchPad
board and cable, TouchPad button board and cable, and TouchPad bracket)

598803-001 Webcam module

598856-002 2 GB memory module (1333-MHz, DDR3)

598859-002 1 GB memory module (1333-MHz, DDR3)

599092-002 4 GB memory module (1333-MHz, DDR3)

602675-001 4.57-cm (1.80-in), 80-GB solid-state drive

602676-001 6.35-cm (2.50-in), 80-GB solid-state drive

613152-001 65-W non-PFC AC adapter

613161-001 65-W PFC AC adapter

614537-001 4.57-cm (1.80-in), 320-GB, 5400-rpm hard drive

614965-001 System board equipped with an Intel Core i7-640LM 2.13-GHz, low-voltage (25-W) processor for use only
in the People's Republic of China and Russia (includes replacement thermal material and replacement
thermal material cleaning kit)

614966-001 System board equipped with an Intel Core i5-520M 2.40-GHz, standard-voltage (35-W) processor for use
only in the People's Republic of China and Russia (includes replacement thermal material and replacement
thermal material cleaning kit)

614966-001 System board equipped with an Intel Core i5-540M 2.53-GHz, standard-voltage (35-W) processor for use
only in the People's Republic of China and Russia (includes replacement thermal material and replacement
thermal material cleaning kit)

614967-001 System board equipped with an Intel Core i7-620M 2.66-GHz, standard-voltage (35-W) processor for use
only in the People's Republic of China and Russia (includes replacement thermal material and replacement
thermal material cleaning kit)

618243-001 6.35-cm (2.50-in), 320-GB, 7200-rpm SED hard drive
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or
speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 72 screws that must be removed, replaced, or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed
when troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components
and parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: This number describes the duration of the warranty period for the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 598797-001. There are 5 rubber feet that attach to the base enclosure in the locations
illustrated below. There are two different sized feet: the four square feet (1) are installed in the four
corners of the base enclosure. The one rectangular foot (2) is installed in the rear/left corner of the
base enclosure.
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Battery

Description Spare part number

9-cell, 93-WH, 2.8-WH Li battery 593587-001

6-cell, 62-WH, 2.8-WH Li battery 593586-001

6-cell, 55-WH, 2.8-WH Li long life battery 593585-001

3-cell, 31-WH, 2.8-WH Li battery 492548-001

3-cell, 28-WH, 2.8-WH Li long life battery 593584-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery lock latch (1) to unlock the battery.

3. Slide the battery release latch (2) to release the battery.

4. Remove the battery (3) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the SIM:

1. Press in on the SIM (1). (The module partially ejects from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to insert the SIM.
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Bluetooth module

Description Spare part number

HP Integrated Module with Bluetooth 2.1 Wireless Technology

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 598766-001.

537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the Bluetooth module:

1. Loosen the captive screw (1) that secures the Bluetooth module compartment cover to the
computer.

2. Lift the cover (2) and release it as far as the Bluetooth module compartment cable allows. The
Bluetooth module compartment cover is included in the Plastics Kit, spare part number
598796-001.

3. Disconnect the Bluetooth module cable from the Bluetooth module (1).

NOTE: See Bluetooth module cable on page 92 for removal information for the Bluetooth
module cable.
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4. Remove the Bluetooth module (2) from the Bluetooth module compartment cover. The Bluetooth
module compartment cover is included in the Plastics Kit, spare part number 598796-001.

5. Remove the Bluetooth module.

Reverse the above procedure to install the Bluetooth module.
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Expansion memory module

Description Spare part number

4096-MB memory module (1333-MHz, DDR3) 599092-002

2048-MB memory module (1333-MHz, DDR3) 598856-002

1024-MB memory module (1333-MHz, DDR3) 598859-002

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the memory module:

1. Position the computer with the front toward you.

2. Loosen the three captive screws (1) that secure the memory module compartment cover to the
computer.

3. Lift the rear edge of the cover (2), swing it up and forward back, and then remove the cover. The
memory module compartment cover is included in the Plastics Kit, spare part number
598796-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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5. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: The memory module is designed with a notch to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the memory module.
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Low-voltage hard drive or solid-state drive
NOTE: The 4.57-cm (1.80-in) hard drive and solid-state drive spare part kit includes a hard drive or
solid-state drive bracket.

Description Spare part number

4.57-cm (1.80-in), 320-GB, 5400-rpm hard drive 614537-001

4.57-cm (1.80-in), 250-GB, 5400-rpm hard drive 598778-001

4.57-cm (1.80-in), 160-GB, 5400-rpm hard drive 598777-001

4.57-cm (1.80-in), 160-GB, solid-state drive 598782-001

4.57-cm (1.80-in), 80-GB, solid-state drive 602675-001

Before removing the low-voltage hard drive or solid-state drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory module compartment cover (see Expansion memory module on page 52).

Remove the low-voltage hard drive or solid-state drive:

1. Position the computer with the front toward you.

2. Loosen the 2 captive screws (1) that secure the hard drive shield to the computer.
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3. Lift the right edge of the hard drive shield (2), swing it up and to the left, and then remove the
cover (3) by sliding it up and to the right at an angle. The hard drive shield is included in the hard
drive spare part kit.

4. Lift the right side of the low-voltage hard drive (1) to disconnect it from the system board.

5. Remove the low-voltage hard drive (2).
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6. If it is necessary to replace the rubber isolator, separate the edges of the isolator from the end of
the low-voltage hard drive, and remove the isolator.

7. If it is necessary to replace the low-voltage hard drive connector, slide the connector off of the
hard drive.

Reverse this procedure to reassemble and install the low-voltage hard drive.
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WLAN module

Description Spare part number

Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Antigua and Barbuda, Argentina,
Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia,
Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras,
Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
Uruguay, the United States, Venezuela, and Vietnam

582564-001

Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

582564-002

Broadcom 4312G 802.11b/g WiFi Adapter for use in Antigua and Barbuda, Argentina, Aruba,
the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia,
Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras,
Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
Uruguay, the United States, Venezuela, and Vietnam

582562-001
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Description Spare part number

Broadcom 4312G 802.11b/g WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

582562-002

Intel Centrino Advanced-N 6200 WLAN module for use in the United States and Canada 572509-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the WLAN module:

1. Loosen the captive screw (1) that secures the wireless module compartment cover to the
computer.
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2. Lift the right edge of the wireless module compartment cover (2), swing it up and to the left, and
remove the cover. The wireless module compartment cover is included in the Plastics Kit, spare
part number 598796-001.

3. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

4. Remove the two Phillips PM2.5×6.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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5. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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WWAN module

Description Spare part number

HP un2420 Broadband Module for use in all countries and regions 531993-001

HP hs2330 HSPA Mobile Broadband Module for use in all countries and regions 574249-001

HP hs2320 HSPA Mobile Broadband Module for use only in Europe, the Middle East, and Africa

NOTE: For use only on selected computer models.

574248-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the wireless module compartment cover (see WLAN module on page 57).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.5×6.0 screws that secure the WWAN module to the computer (2).
(The edge of the module opposite the socket rises.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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Optical drive
NOTE: The optical drive is an optional feature and is available only on computer models equipped
with a low voltage (25-W) processor.

Description Spare part number

DVD±RW and CD-RW SuperMulti Double-Layer Drive 598776-001

DVD-ROM Drive 598775-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory module compartment cover (see Expansion memory module on page 52).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the two Phillips PM2.0×5.0 screws that secure the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (1) and press the
tab to the right to release the optical drive from the computer.
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4. Remove the optical drive (2) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

6. Remove the two Phillips PM2.0×4.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Standard-voltage hard drive or solid-state drive
NOTE: Installation of the 6.35-cm (2.50-in) hard drive or solid-state drive in the hard drive bay is not
supported. The 6.35-cm (2.50-in) hard drive or solid-state drive cannot be installed when the optical
drive is installed.

Description Spare part number

2.50-in, 500-GB, 7200-rpm hard drive 598781-001

2.50-in, 320-GB, 7200-rpm hard drive 598780-001

2.50-in, 320-GB, 7200-rpm SED hard drive 618243-001

2.50-in, 250-GB, 7200-rpm hard drive 598779-001

Hard drive carrier 598786-001

1.80-in 160-GB, solid-state drive 598783-001

1.80-in 80-GB, solid-state drive 602676-001

NOTE: The standard-voltage hard drive or solid-state drive must be installed in the optical drive
bay, and replaces the optical drive.

Before removing the standard-voltage hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery. (See Battery on page 48)

5. Remove the memory module compartment cover (see Expansion memory module on page 52).
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Remove the standard-voltage hard drive:

1. Remove the four Phillips PM3.0×3.0 screws (1) and the two Phillips PM2.0×5.0 screws (2) that
secure the hard drive carrier to the computer.
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2. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (1) and press the
tab to the right to release the hard drive carrier (2) from the computer.

3. Remove the four Phillips PM3.0×3.0 screws that secure the standard-voltage hard drive to the
hard drive carrier.

4. Lift the front edge of the standard-voltage hard drive (1) until it clears the front edge of the hard
drive carrier.
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5. Remove the standard-voltage hard drive (2) by sliding it up and away from the hard drive carrier
at an angle.

Reverse the above procedure to reassemble and install the standard-voltage hard drive.
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Switch cover and keyboard

Description Spare part number

Switch cover (includes power button board and cable) 598800-001

Keyboard for use in country/
region

Spare part number Keyboard for use in country/
region

Spare part number

Belgium 598790-A41 Norway 598790-091

Brazil 598790-201 Portugal 598790-131

Bulgaria 598790-261 Russia 598790-251

The Czech Republic 598790-221 Saudi Arabia 598790-171

Denmark 598790-081 Slovakia 598790-231

France 598790-051 Slovenia 598790-BA1

French Canada 598790-121 South Korea 598790-AD

Germany 598790-041 Spain 598790-071

Greece 598790-DJ Sweden and Finland 598790-B71

Hungary 598790-211 Switzerland 598790-BG1

Iceland 598790-DD1 Taiwan 598790-AB1

Israel 598790-BB1 Thailand 598790-281

Italy 598790-061 Turkey 598790-141

Japan 598790-291 The United Kingdom and Singapore 598790-031

Latin America 598790-161 The United States 598790-001

The Netherlands 598790-B31

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory module compartment cover (see Expansion memory module on page 52).

6. Remove the wireless module compartment cover (see WLAN module on page 57).

Remove the switch cover and keyboard:

1. Loosen the three captive screws (1) that secure the switch cover to the computer.
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2. Loosen the four captive screws (2) that secure the keyboard to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the display as far as possible.

5. Lift the right side of the switch cover (1) to detach it from the computer.

6. Release the switch cover (2) as far as the power button board and capacitive board cables
allow.

7. Lift the rear edge of the keyboard (1) until it rests at an angle.

8. Slide the keyboard (2) back until the tabs on the front edge of the keyboard disengage from the
slots in the top cover.
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9. Swing the rear edge of the keyboard (3) up and forward until the keyboard rests upside down on
the palm rest.

10. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

11. Release the ZIF connector (3) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable (4) from the system board.

12. Remove the keyboard (5).

13. Disconnect the power button board cable (1) and the capacitive board cable (2) from the system
board.
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14. Remove the switch cover (3).

Reverse this procedure to install the switch cover and keyboard.
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RTC battery

Description Spare part number

RTC battery 481089-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

Remove the RTC battery:

▲ Use a flat-bladed, non-conductive tool to remove the RTC battery from the socket.

Reverse this procedure to install the RTC battery.
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Primary memory module

Description Spare part number

4096-MB memory module (1333-MHz, DDR3) 599092-002

2048-MB memory module (1333-MHz, DDR3) 598856-002

1024-MB memory module (1333-MHz, DDR3) 598859-002

Memory shield (includes one captive screw) 598793-001

Before removing the primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

Remove the primary memory module:

1. Remove the Phillips PM2.0×5.0 screw (1) that secures the primary memory module shield to the
top cover.

2. Remove the primary memory module shield (2). The primary memory module shield is available
using spare part number 598793-001.
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3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: The memory module is designed with a notch to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the memory module.
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Display assembly

Description Spare part number

12.1-in, WXGA AntiGlare LED display assembly for use only with computer models equipped with a
webcam (includes display panel cable, WLAN antenna transceivers and cables, and WWAN
antenna transceivers and cables.

598794-001

12.1-in, WXGA AntiGlare LED display assembly for use only with computer models not equipped
with a webcam (includes display panel cable, WLAN antenna transceivers and cables, and WWAN
antenna transceivers and cables.

598795-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the memory module compartment cover (see Expansion memory module on page 52).

6. Remove the wireless module compartment cover (see WLAN module on page 57).

7. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 57) and the WWAN module (see WWAN module on page 61).

8. Remove the switch cover and keyboard (see Switch cover and keyboard on page 69).

Remove the display assembly:

1. Close the computer and turn it upside down, with the rear panel toward you.

2. Remove the two rubber screw covers (1) and the two Torx T8M2.0×6.0 screws (2) from the
bottom of the base enclosure.

3. Remove the two Torx T8M2.0×6.0 screws (3) from the rear panel.
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4. Turn the computer right-side up, with the front toward you.

5. Open the display as far as it will open.

6. Disconnect the display panel cable (1) from the system board and release it from the clip built
into the top cover.

7. Release the wireless antenna cables from the clips (2) built into the top cover.

8. Disconnect the microphone cable (1) from the system board.
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9. Release the microphone cable and the wireless antenna cables from the clips (2) built into the
top cover.

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.

10. Remove the two Torx T8M2.5×6.0 screws (1) that secure the display assembly to the computer.

NOTE: The screw on the left display hinge also secures a display panel cable ground loop (2).
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11. Lift the display assembly straight up to remove it (3).
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12. If it is necessary to replace the display bezel or any of the display assembly internal
components:

a. Remove the four rubber screw covers (1) and the four Torx T8M2.5×5.0 screws (2) that
secure the display bezel to the display assembly.

NOTE: The rubber screw covers on the display bezel top edge are thicker than the rubber
screw covers on the display bezel bottom edge.

b. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom edge
(3) of the display bezel until the bezel disengages from the display enclosure.
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c. Remove the display bezel (4). The display bezel is available using spare part numbers
598770-001 (for use only with computer models equipped with a webcam) and 598771-001
(for use only with computer models not equipped with a webcam).

13. If it is necessary to replace the ambient light sensor board:

a. Release the ZIF connector to which the ambient light sensor board is connected, and then
disconnect the cable (1) from the board.

b. Remove the Torx T8M2.0×3.0 screw (2) that secures the ambient light sensor board to the
display enclosure.
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c. Remove the ambient light sensor board (3). The ambient light sensor board is available
using spare part number 598761-001.

14. If it is necessary to replace the webcam module, display hinges, display panel cable, or display
enclosure:

a. Release the display panel cable (1) from the clips built into the display enclosure.

b. Disconnect the display panel cable (2) from the ambient light sensor board.

c. Remove the two Torx T8M2.5×6.0 screws (1) that secure the display panel and hinges to
the display enclosure.

d. Lift the bottom edge of the display panel (2) until it rests at an angle.
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e. Disconnect the display panel cable (3) from the passthrough board.

f. Remove the display panel.

g. Remove the two Phillips PM2.0×4.0 screws (1) that secure each display hinge to the
display panel.

h. Remove the display hinges (2). The display hinges are included in the Display Hinge Kit,
spare part number 598773-001.

i. Remove the Torx T8M2.0×4.0 screws (3) that secure the hinge covers to the hinges.

j. Remove the hinge covers (4). The hinge covers are included in the Plastics Kit, spare part
number 598796-001.

k. Disconnect the webcam module cable (1) from the passthrough board.

l. Release the webcam module (2) from the clip built into the display enclosure. The webcam
module is available using spare part number 598772-001.
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m. Route the webcam module cable (3) through the slot built into the display enclosure.

Reverse this procedure to reassemble and install the display assembly.
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Top cover
NOTE: The top cover spare part kit includes the TouchPad board and cable, TouchPad button
board and cable, and TouchPad bracket.

Description Spare part number

For use only on computer models equipped with a fingerprint reader (includes fingerprint reader and
cable)

598801-001

For use only on computer models not equipped with a fingerprint reader 598802-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

d. Display assembly (see Display assembly on page 76)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the four rubber screw covers (1) on the front edge of the base enclosure.

3. Remove the two rubber screw covers (2) in the rear corners of the base enclosure.
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4. Remove the following screws:

(1) Four Torx T8M2.5×5.0 screws

(2) Three Torx T8M2.5×6.0 screws

(3) One Torx T8M2.0×5.0 screw.

(4) One Torx T8M2.0×4.0 screw.

5. Turn the computer right-side up, with the front toward you.

6. Release the ZIF connector to which the card reader board cable is attached, and then
disconnect the card reader board cable (1) from the system board.

7. Release the ZIF connector to which the TouchPad cable is attached, and then disconnect the
TouchPad cable (2) from the system board.
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8. Release the ZIF connector to which the fingerprint reader board cable is attached, and then
disconnect the fingerprint reader board cable (3) from the system board.

9. Lift the rear edge of the top cover (1), and then swing it up and forward until it rests at an angle.

10. Lift the front edge of the top cover (2) until it disengages from the base enclosure.

11. Remove the top cover.

Reverse this procedure to install the top cover.
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Card reader board

Description Spare part number

Card reader board (includes cable) 598768-001

Card reader board bracket 598767-001

Before removing the card reader board and bracket, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 85)
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Remove the card reader board and bracket:

1. Detach the card reader board cable (1) from the surface of the top cover (2). (The card reader
board cable is attached to the top cover by double-sided tape.)

2. Turn the top cover upside down, with the front toward you.

3. Remove the two Phillips PM2.0×2.0 broad head screws (1) and the Phillips PM2.0×5.0 screw (2)
that secure the card reader board bracket to the top cover.

4. Lift the front edge of the card reader board bracket (3) until it rests at an angle.
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5. Remove the card reader board bracket (4) by sliding it up and forward at an angle.

6. Slide the card reader board (1) to the right until the tabs on the card reader board disengage
from the slots on the top cover.

7. Remove the card reader board (2) and cable.
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Reverse this procedure to install the card reader board, cable, and bracket.

Speaker

Description Spare part number

Speaker 598799-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 85)

Remove the speaker:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the Phillips PM2.0×4.0 screw (2) and the Phillips PM2.0×6.0 screw (3) that secure the
speaker to the base enclosure.
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3. Remove the speaker (4) from the base enclosure.

Reverse this procedure to install the speaker.

Bluetooth module cable
NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 598766-001.

Before removing the Bluetooth module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 85)
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Remove the Bluetooth module cable:

1. Release the Bluetooth module cable (1) from the opening in the base enclosure.

2. Disconnect the Bluetooth module cable (2) from the system board.

3. Remove the Bluetooth module cable.

Reverse this procedure to install the Bluetooth module cable.
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System board
NOTE: The system board spare part kit includes the processor, replacement thermal material, and
a replacement thermal material cleaning kit.

Description Spare part number

System boards equipped with a standard-voltage (35-W) processor:

Equipped with an Intel Core i7-620M 2.66-GHz processor for use in all countries and regions except
the People's Republic of China and Russia

598765-001

Equipped with an Intel Core i7-620M 2.66-GHz processor for use only in the People's Republic of
China and Russia

614968-001

Equipped with an Intel Core i5-540M 2.53-GHz processor for use in all countries and regions except
the People's Republic of China and Russia

598764-001

Equipped with an Intel Core i5-540M 2.53-GHz processor for use only in the People's Republic of
China and Russia

614967-001

Equipped with an Intel Core i5-520M 2.40-GHz processor for use in all countries and regions except
the People's Republic of China and Russia

598763-001

Equipped with an Intel Core i5-520M 2.40-GHz processor for use only in the People's Republic of
China and Russia

614966-001

System boards equipped with a low-voltage (25-W) processor:

Equipped with an Intel Core i7-640M 2.13-GHz processor for use in all countries and regions except
the People's Republic of China and Russia

598762-001

Equipped with an Intel Core i7-640M 2.13-GHz processor for use only in the People's Republic of
China and Russia

614965-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Bluetooth module (see Bluetooth module on page 50)

b. Low-voltage hard drive (see Low-voltage hard drive or solid-state drive on page 54)

c. Memory module compartment cover (see Expansion memory module on page 52)

d. Wireless module compartment cover (see WLAN module on page 57)

e. Optical drive (see Optical drive on page 63) or standard-voltage hard drive (see Standard-
voltage hard drive or solid-state drive on page 65)

f. Switch cover and keyboard (see Switch cover and keyboard on page 69)

g. Display assembly (see Display assembly on page 76)
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h. Top cover (see Top cover on page 85)

i. Speaker (see Speaker on page 91)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● SIM (see SIM on page 49)

● Memory modules (see Expansion memory module on page 52 and Primary memory module
on page 74)

● WLAN module (see WLAN module on page 57)

● WWAN module (see WWAN module on page 61)

● RTC battery (see RTC battery on page 73)

● Bluetooth module cable (see Bluetooth module cable on page 92)

● Modem module (see Modem module on page 97)

● Fan/heat sink assembly (see Fan/heat sink assembly on page 98)

Remove the system board:

1. Release the ZIF connector to which the LED board cable is attached, and then disconnect the
LED board cable (1) from the system board.

2. Remove the Torx8 T8M2.5×5.0 screw (2) that secures the system board to the base enclosure.

3. Flex the left side of the base enclosure (1) until the RJ-11 jack and USB ports are clear of the
openings in the base enclosure.

4. Use the optical drive connector (2) to lift the left side of the system board (3) until it rests at an
angle.
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5. Remove the system board (4) from the base enclosure by sliding it up and to the left.

Reverse this procedure to install the system board.

96 Chapter 4   Removal and replacement procedures ENWW



Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 598766-001.

Description Spare part number

For use in all countries and regions except Australia and New Zealand 510099-001

For use only in Australia and New Zealand 510099-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48), and then remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 85)

f. System board (see System board on page 94)

Remove the modem module:

1. Remove the two Phillips PM2.0×4.0 screws (1) that secure the modem module to the system
board.

2. Lift the modem module (2) straight up to disconnect it from the system board.
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3. Disconnect the modem module cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.

Fan/heat sink assembly

Description Spare part number

For use only on computer models equipped with a standard-voltage (35-W) processor 598789-001

For use only on computer models equipped with a low-voltage (25-W) processor 598788-001

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 48), and then remove the following components:

5. Remove the following components:

a. Memory module compartment cover (see Expansion memory module on page 52)

b. Wireless module compartment cover (see WLAN module on page 57)

c. Switch cover and keyboard (see Switch cover and keyboard on page 69)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 85)

f. System board (see System board on page 94)

Remove the fan/heat sink assembly:

1. Turn the system board upside down, with the front toward you.

2. Disconnect the fan cable (1) from the system board.

3. Remove the Torx T8M2.0×5.0 screw (2) that secures the fan/heat sink assembly to the system
board.

4. Following the 1, 2, 3, 4 sequence stamped into the fan/heat sink assembly, loosen the four
captive screws (3) that secure the fan/heat sink assembly to the system board.

5. Remove the fan/heat sink assembly (4).
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan/heat sink
assembly and system board each time the fan/heat sink assembly is removed. Thermal paste is
located on the processor/Northbridge component (1) and the fan/heat sink assembly section that
services it (2). A thermal pad is used on the graphics subsystem conponent (3) and the fan/heat sink
assembly section that services it (4). Replacement thermal material is included with all fan/heat sink
assembly and system board spare part kits.

Reverse this procedure to install the fan/heat sink assembly.
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5 Computer Setup

Windows 7
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test–Verifies the system components needed
for starting the computer.

● Run-In Test–Runs a comprehensive check on system
memory.

● Hard Disk Test–Runs a comprehensive self-test on any
hard drive in the system.

● Memory Test–Runs a comprehensive test on any
memory installed in the computer.

● Battery Test–Runs a comprehensive test on any
batteries installed in the computer.

● Error Log–Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password

User Management (requires a BIOS administrator password)

Create New BIOS User Account ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-P Enable/disable Anti-Theft Protection.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the low-
voltage hard drive or the standard-voltage hard drive in the
Upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the MultiBook Express Boot Popup delay in
seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)
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Select To do this

Device Configurations (continued) NOTE: Availability of these options varies by computer
model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb Write Protect (disabled by
default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Multi Core CPU (enabled by default).

● Intel HT Technology (enabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Ambient Light Sensor.

● Enable/disable the Notebook Upgrade bay device
(enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart Card slot.

● Enable/disable the eSATA port.

AMT Options ● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (Ctrl-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on next boot.

● Select Terminal Emulation Mode.

◦ ANSI

◦ VT100

● Enable/disable Firmware Progress Event Support.

● Enable/disable Initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.

108 Chapter 5   Computer Setup ENWW



Windows Vista
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test–Verifies the system components needed
for starting the computer.

● Run-In Test–Runs a comprehensive check on system
memory.

● Hard Disk Test–Runs a comprehensive self-test on any
hard drive in the system.

● Memory Test–Runs a comprehensive test on any
memory installed in the computer.

● Battery Test–Runs a comprehensive test on any
batteries installed in the computer.

● Error Log–Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password

User Management (requires a BIOS administrator password)

Create New BIOS User Account ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-P Enable/disable Anti-Theft Protection.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the low-
voltage hard drive or the standard-voltage hard drive in the
Upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the MultiBook Express Boot Popup delay in
seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)
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Select To do this

Device Configurations (continued) NOTE: Availability of these options varies by computer
model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb Write Protect (disabled by
default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Multi Core CPU (enabled by default).

● Intel HT Technology (enabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Ambient Light Sensor.

● Enable/disable the Notebook Upgrade bay device
(enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart Card slot.

● Enable/disable the eSATA port.

AMT Options ● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (Ctrl-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on next boot.

● Select Terminal Emulation Mode.

◦ ANSI

◦ VT100

● Enable/disable Firmware Progress Event Support.

● Enable/disable Initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.
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Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test–Verifies the system components needed
for starting the computer.

● Run-In Test–Runs a comprehensive check on system
memory.

● Hard Disk Test–Runs a comprehensive self-test on any
hard drive in the system.

● Memory Test–Runs a comprehensive test on any
memory installed in the computer.

● Battery Test–Runs a comprehensive test on any
batteries installed in the computer.

● Error Log–Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password

User Management (requires a BIOS administrator password)

Create New BIOS User Account ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-P Enable/disable Anti-Theft Protection.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the low-
voltage hard drive or the standard-voltage hard drive in the
Upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the MultiBook Express Boot Popup delay in
seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)
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Select To do this

Device Configurations (continued) NOTE: Availability of these options varies by computer
model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb Write Protect (disabled by
default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Multi Core CPU (enabled by default).

● Intel HT Technology (enabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Ambient Light Sensor.

● Enable/disable the Notebook Upgrade bay device
(enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart Card slot.

● Enable/disable the eSATA port.

AMT Options ● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (Ctrl-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on next boot.

● Select Terminal Emulation Mode.

◦ ANSI

◦ VT100

● Enable/disable Firmware Progress Event Support.

● Enable/disable Initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.

124 Chapter 5   Computer Setup ENWW



6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 21.34 cm 8.40 in

Width 28.22 cm 11.11 in

Height (front to back) 2.80 cm to 3.40 cm 1.10 in to 1.34 in

Weight 1.50 kg 3.31 lbs

Input power

Operating voltage 19.0 V dc @ 3.5 A – 65 W

Operating current 3.5 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 90%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

12.1-in display specifications
 Metric U.S.

Dimensions

Width 16.9 cm 6.7 in

Depth 26.2 cm 10.3 in

Diagonal 30.8 cm 12.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40° horizontal, +20°/-40° vertical (typical)
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Hard drive specifications
 500-GB* 320-GB* 250-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms

Logical blocks 976,752,240 625,121,433 488,376,120

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW SuperMulti Double-Layer Drive
specifications

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-
R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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DVD-ROM Drive specifications
Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD (Photo-CD,
CDEXTRA, Portfolio, CD-R, CD-RW),
CDR, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R,
DVD-RW, DVD+R, DVD+RW, DVD-
RAM

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 3,600 KB/sec
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7 Backup and recovery

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only)

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).
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NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition or the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the Windows partition or the HP Recovery partition is not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section.
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3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Be sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD,
go to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Windows Vista
To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
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The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.
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NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition or the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to
recover your operating system and software. To check for the presence of a recovery partition, select
Start > Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives
section of the window.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section.
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3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Be sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Windows XP
To protect your information, use the Windows Backup utility to back up files and folders or create
recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the
discs to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system as well as software and drivers. Software, drivers, and
updates not installed by HP must be manually reinstalled. Personal files must be restored from a
backup.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Shut down the computer.

3. Insert the Operating System disc into the optical drive.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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8 Connector pin assignments

1394

Pin Signal

1 TPB-

2 TPB+

3 TPA-

4 TPA+

Audio-in (microphone)/audio-out (headphone) combo

Pin Signal

1 Audio signal in (microphone) / audio out, left channel
(headphone)

2 Audio signal in (microphone) / audio out, right channel
(headphone)

3 Ground (microphone) / ground (headphone)
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DisplayPort

Pin Signal

1 ML_lane 0 (positive)

2 Ground

3 Lane 0 (negative)

4 Lane 1 (positive)

5 Ground

6 Lane 1 (negative)

7 Lane 2 (positive)

8 Ground

9 Lane 2 (negative)

10 Lane 3 (positive)

11 Ground

12 Lane 3 (negative)

13 Connectecd to ground

14 Connected to ground

15 Auxiliary channel (positive)

16 Ground

17 Auxiliary channel

18 Hot plug detect

19 Return for power

20 Power for connector
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground
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9 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzlerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
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19. Disconnect the display cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 port

connector pinout 143
location 18

A
AC adapter, spare part

numbers 34, 39
ambient light sensor board

location 9
removal 81
spare part number 30, 37, 81

antenna
disconnecting 59, 61
location 8

audio, product description 3
audio-in jack

connector pinout 143
location 18

audio-out jack
connector pinout 143
location 18

B
base enclosure, spare part

number 26, 37
battery

removal 48
spare part

numbers 26, 35, 36, 37, 48
battery bay 19
battery light 15
battery release latch 19
Bluetooth module

removal 50
spare part number 26, 35, 50

Bluetooth module cable,
removal 92

Bluetooth module compartment
cover

illustrated 33
removal 50

bottom components 19
business card slot 15
button components 10
buttons

display release 15
keyboard light 8
pointing stick 14
power 11
QuickLook 11
QuickWeb 11
TouchPad 14
TouchPad button 14
TouchPad on/off 11, 14
volume down 11
volume mute 11
volume up 12
wireless 11

C
Cable Kit, spare part

number 34, 37
cables, service considerations 42
card reader board

removal 88
spare part number 25, 37, 88

card reader board bracket
removal 88
spare part number 25, 37, 88

chipset, product description 1
components

bottom 19
buttons 10
display 8
front 15
keys 13
left-side 16

pointing device 14
rear 17
right-side 18

computer feet
locations 47
spare part number 47

computer specifications 125
connector pinout

1394 port 143
audio-in jack 143
audio-out jack 143
DisplayPort 144
external monitor port 145
headphone jack 143
microphone jack 143
modem jack 146
monitor port 145
network jack 146
RJ-11 jack 146
RJ-45 jack 146
Universal Serial Bus (USB)

port 147
connectors, service

considerations 42

D
diskette drive, precautions 42
display assembly

removal 76
spare part numbers 24, 39, 76

display bezel
removal 80
spare part numbers 30, 37, 80

display components 8
display enclosure, spart part

number 30, 37
Display Hinge Kit, spare part

number 30, 37, 83
display panel cable, spare part

number 30, 37
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display panel, product
description 1

display release button 15
display specifications 126
DisplayPort

connector pinout 144
docking connector 18
docking station, spare part

number 34, 37
docking support, product

description 4
drive light 15
drives, preventing damage 42
DVD-ROM Drive

precautions 42
removal 63
spare part

number 26, 32, 37, 63
specifications 129

DVD±RW and CD-RW SuperMulti
Double-Layer Drive

precautions 42
removal 63
spare part

number 26, 32, 37, 63
specifications 128

E
electrostatic discharge 43
esc key 13
Ethernet, product description 3
ExpressCard slot 18
ExpressCard slot bezel,

illustrated 33
external media cards, product

description 4
external monitor port

connector pinout 145
location 18

F
fan/heat sink assembly

removal 98
spare part

numbers 26, 37, 38, 98
feet

locations 47
spare part number 47

fingerprint reader 12
fn key 13

front components 15
function keys 13

G
graphics, product description 1
grounding equipment and

methods 45

H
hard drive

precautions 42
product description 2
removal 54, 65
spare part

numbers 28, 29, 31, 32, 37
, 39, 54, 65

specifications 127
hard drive bay 16, 19, 20
hard drive carrier

removal 65
spare part

number 26, 32, 37, 65
hard drive shield

removal 55
headphone jack

connector pinout 143
location 18

hinge
removal 83
spare part number 30, 37, 83

hinge cover
illustrated 33

I
internal storage, product

description 2

J
jacks

audio-in 18
audio-out 18
headphone 18
microphone 18
modem 16
network 17
RJ-11 16
RJ-45 17

K
key components 13

keyboard
product description 4
removal 69
spare part numbers 24, 38, 69

keyboard light 8
keyboard light button 8
keys

esc 13
fn 13
function 13
numeric keypad 13
Windows application 13
Windows logo 13

L
left-side components 16
lights

battery 15
drive 15
keyboard 8
power 15
webcam 8
wireless 15

M
mass storage device

removal 54
spare part

numbers 28, 31, 32, 54
memory module

product description 1
removal 52, 74
spare part

numbers 25, 39, 52, 74
memory module compartment 19
memory module compartment

cover
illustrated 33
removal 52

memory shield
removal 74
spare part number 25, 38, 74

microphone
location 8
product description 3

microphone jack
connector pinout 143
location 18

model name 1
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modem jack
connector pinout 146
location 16

modem module
product description 3
removal 97
spare part numbers 26, 35, 97

monitor port
connector pinout 145
location 18

N
network jack

connector pinout 146
location 17

numeric keypad keys 13

O
operating system, product

description 5
optical drive

location 16
precautions 42
product description 2
removal 63
spare part

numbers 26, 32, 37, 63
specifications 128, 129

optical drive bay 20
optical drive bezel, illustrated 33

P
packing guidelines 44
plastic parts 41
Plastics Kit

contents 33
spare part number 25, 33, 39

pointing device
components 14
product description 4

pointing stick 14
pointing stick button 14
ports

1394 18
external monitor 18
monitor 18
product description 4
Universal Serial Bus

(USB) 16, 17
power button 11
power connector 16

power cord
set requirements 149
spare part numbers 34, 35

power light 15
power requirements, product

description 4
processor, product description 1
product description

audio 3
chipset 1
display panel 1
docking support 4
Ethernet 3
external media cards 4
graphics 1
hard drives 2
internal storage 2
keyboard 4
memory module 1
microphone 3
modem module 3
operating system 5
optical drives 2
pointing devices 4
ports 4
power requirements 4
processors 1
product name 1
security 4
solid state drive 2
video 3
wireless 3

product name 1

Q
QuickLook button 11
QuickWeb button 11

R
rear components 17
removal/replacement

preliminaries 41
procedures 46

right-side components 18
RJ-11 jack

connector pinout 146
location 16

RJ-45 jack
connector pinout 146
location 17

RTC battery
removal 73
spare part number 25, 35, 73

Rubber Kit, spare part
number 26, 39

S
Screw Kit, spare part

number 34, 39
SD Card Reader 18
security cable slot 18
security, product description 4
serial number 21, 46
service considerations 41
SIM

removal 49
spare part number 49

SIM slot 19
smart card reader 16
solid-state drive

product description 2
removal 54, 65
spare part

numbers 28, 29, 31, 32, 37
, 39, 54, 65

speaker
removal 91
spare part number 25, 39, 91

speakers 15, 19
specifications

computer 125
display 126
DVD-ROM Drive 129
DVD±RW and CD-RW

SuperMulti Double-Layer
Drive 128

hard drive 127
optical drive 128, 129

static-shielding materials 45
switch cover

removal 69
spare part number 24, 39, 69

system board
removal 94
spare part

numbers 25, 37, 39, 94

T
thermal material,

replacement 100
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tools required 41
top cover

removal 85
spare part numbers 25, 39, 85

TouchPad 14
TouchPad button 14
TouchPad on/off button 11, 14
TouchPad scroll zone 14
transporting guidelines 44

U
Universal Serial Bus (USB) port

connector pinout 147
location 16, 17

V
vents 18, 19
video, product description 3
volume down button 11
volume mute button 11
volume up button 12

W
webcam 8
webcam light 8
webcam module

removal 82, 83
spare part

number 30, 39, 82, 83
Windows applications key 13
Windows logo key 13
wireless antenna

disconnecting 59, 61
location 8

wireless button 11
wireless light 15
wireless module compartment 20
wireless module compartment

cover
illustrated 33
removal 59

wireless, product description 3
WLAN antenna

disconnecting 59
location 8

WLAN module
removal 57
spare part

numbers 26, 35, 36, 57
workstation guidelines 44

WWAN antenna
disconnecting 61
location 8

WWAN module
removal 61
spare part numbers 28, 35, 61
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